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1  Introduction

ToDo List was designed with a single goal in mind — to provide a convenient, fast and
compact way to keep lists of things. It won't schedule your meetings for you or sound an
alarm when an event is supposed to happen, but by focusing on a single task, ToDo List
is easy to use, small and fast. It uses very little memory, so you can leave it in the
background all day.

ToDo List works with System 7.0 or greater (including MacOS 8.6) and is compatible
with all Apple Macintosh models. ToDo List is distributed as a “fat application”, which
means that the application includes machine instructions to run “native” on both the
original 680x0-based Macintoshes and the new Power Macintoshes. If you only have one
type of Macintosh and want a smaller application, ToDo List has built-in support for
removing either the 68K or Power PC code (see the About ToDo List... menuitem.)

With item dates displayed, you can use ToDo List to keep track of future events, or as a
handy diary.  If you put an alias to ToDo List into the Startup Items folder, in the System
Folder, it will run automatically when your Macintosh starts up and always be a mouse
click away. Some of the unique features of ToDo List include:

Multiple Categories
ToDo List lets you organize your items into multiple categories by simply creating
several documents. The number of ToDo List documents is limited only by available
memory. ToDo List can also remember and automatically reopen all documents you had
open the last time you used it. The automatic saving of your documents is also available.

Dated Items
ToDo List will organize items by date if desired, and will take care of carrying forward
unfinished items automatically. It will also optionally provide a miniature calendar across
the top of any window.  Dates are displayed using the international facilities built in to
the Macintosh, so they should appear correctly for the current country.

Import and Export Functionality
ToDo List lets you: import/export to do items between any application that can work with
tab-delimited text files, create a world wide web page and synchronize a ToDo List
document to the to do items on a Newton PDA. You can even automatically create a list
of visted Web pages.

Speech Support
If the Speech Manager is installed, ToDo List can speak all of the items in a list or just
the current day’s unfinished items.
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Recorded Memos
If you have a microphone, ToDo List will let you record audio memos.

Direct Manipulation
To make maintaining your lists of things to do as easy and fast as possible, ToDo List
takes advantage of direct manipulation with the mouse wherever possible. In addition to
menu commands for all actions, you can also usually produce the same effect by directly
clicking on an item in the list. For instance, to play the sound for an item, just click on the
speaker icon.

Drag and Drop
ToDo List also includes full support for Apple’s Drag and Drop (part of System 7.5 or
later and available for earlier System 7’s).  You can drag items within a list to change
their order, select items and drag them between document windows or to other Drag and
Drop-enabled applications.  Items can also be dragged to the desktop to make “clippings”
files.

AppleScript Support
ToDo List offers extensive AppleScript support. A couple of sample scripts are included
to show you how you might use these new events to get ToDo List to read a list of items,
and a complete guide to scripting ToDo List can be found in Chapter 6.  Since
AppleScripts can be placed in your Startup Items folder, you can place a script there that
will run ToDo List, open some documents and speak today's items.

Balloon Help
Balloon help is provided for all of the menu items and windows.

Full Undo Support
ToDo List includes complete support for undo and redo.
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2  Using ToDo List

 

ToDo List is organized around the notion of ToDo List documents, each of which can
contain any number of items. The number of documents that you can have open at once
is limited only by memory.

As a convenience, ToDo List will optionally remember which documents you had open
(along with the location and size of their windows) and automatically reopen them each
time you launch ToDo List. It will also automatically save changes on a regular interval
or when you close the document if desired.  See the Preferences section for information
on how to set these and other preferences.

One of the most convenient ways to use ToDo List is to have it automatically launch
when you startup your Macintosh.  To do this first make an alias of the ToDo List
application.  Then place the alias in the Startup Items folder inside the System Folder.

Since ToDo List uses very little memory, and won’t slow down other programs while in
the background, you can safely choose to leave it open.
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2.1 The ToDo List Window

Almost all actions in ToDo List can be invoked from either a menu or directly from the
window. This section goes over the window and points out the places that you can click
or drag to manipulate the item list.

The exact appearance of each ToDo List window depends on the preferences that have
been selected for that document, however here is an example:

 
The small calendar across the top of the window is optional (see the Preferences
section).

You can shift the months displayed backward or forward by clicking on the arrows to
either side of the calendar. If you hold down the Option, Command, or Control key
while clicking, the calendar will shift by one year instead of one month. If you hold the
mouse button down on either of the arrow buttons the months will continue to scroll in
that direction until the button is released.  Initially the calendar begins with the current
month, but ToDo List will remember where it was left when the document is closed.

As a short cut, you can double-click on a date in the calendar to create a new item with
that date. If the calendar is being displayed, but dates are not being used, in the current
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document, a double-click creates a new item with the current date. If you single-click on
a date, the item list will be scrolled to the  first item that falls on or after that date.

Most of the commands in the Item menu apply to the currently selected item in the list.
You can select items by clicking on a single item or clicking and dragging to select
several items. If you hold down the shift key while clicking, ToDo List will extend the
range of items selected. If you hold down the command key ( ) while clicking on an
item, it is added to the selection (allowing for discontinuous selections). Since all of the
selected items might not be visible at one time, ToDo List shows you how many items
out of the total number are currently selected (e.g. "1/8 Items").

If you have one or more items selected, you can drag to move them to another location in
the list. If you hold the option key down you will copy the selections to the new location.
As you drag a dark line will follow the mouse indicating where the items will be inserted
if you release the mouse. The date and priority of the items will change if necessary to
match the new location. Note that the selection you drag can be discontinuous. See Drag
and Drop below.

If a single item is currently selected, the up and down arrow keys on the keyboard will
shift the selection up or down one item, scrolling the list if necessary. The Page Up and
Page Down keys on extended keyboards scroll the list up or down a window at a time.
Pressing the Enter or Return key with exactly one item selected will edit that item.
Pressing the Escape (Esc) key will cancel the current selection.

When ToDo List is considering a click on an item, the item area is divided up into two or
three zones. The full left edge of the item (including the area below the check box for a
multi-line item) is the check box area. Clicking in this area reverses (toggles) the current
status of the item. Items with a check mark are considered "finished".  If there is audio
with an item then clicking on the speaker icon will play the sound. If you want to stop
playing the sound press command-period
( -.). Clicking on the item text selects it; double clicking brings up the Edit Item dialog.

ToDo List windows have no horizontal scroll bar because the program automatically
wraps the text of each item to fit the current width. If the text for an item is too long to fit
on one line, it is automatically continued on the next. ToDo List uses the international
guides built into the Macintosh to determine the word boundaries for breaking lines.

2.2 Creating and Editing Items

There are five ways to add new items to a ToDo List document:  Insert New Item...,
from the Item menu, Record New Memo... from the Sound menu, the Paste command
from the Edit menu, dragging items between windows and by double clicking in an
empty part of the list window. If the list is displaying dates and you double-click on a
visible date, the new item dialog will default to that date.
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Insert New Item... brings up the following dialog box:

Each item can contain up to 255 characters of text. The text can contain carriage returns
to add addition line breaks. By default (see the Preferences section) you insert a carriage
return in the text by typing Return while holding down the Option, Control or Shift
key. Pressing Return without any of these modifiers is the same as clicking on the OK
button. The OK button is only enabled when the item isn’t empty (e.g. you have a
recorded memo or some text in the item).

ToDo List also associates a creation date and last modification date with each item. If
dates are being displayed in the document (see Preferences), the item is also given a due
date. The first time you create an item, the date pop-up menus will default to today’s
date. After that, they default to the last date used. You can click on the Today button at
any time to reset the popup menus to today’s date.  The order of the month, day and year
popups in the Edit Item dialog is determined by your System.  You can change their order
by changing the way dates are displayed in the Date & Time control panel.

If you check the Priority Item checkbox, the item will be displayed in red and
underlined. Priority items are inserted before the non-priority items for the same date.
The priority status of an item (or items) can also be changed with the Toggle Priority
Status menu command.

If you check the Finished Item checkbox, the item will be displayed with a checkmark.
The finished status can also be changed by clicking the checkbox in the ToDo List
window or by the Toggle Finished Status command.
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You can record a memo to go with the item by clicking on the Record button. The
standard recording dialog will appear:

The number of seconds you can record is determined by the amount of available memory.
If you want to record longer memos, increase the amount of memory allocated to ToDo
List (Get Info... in the Finder).

If you click on the Save button, a new item is created with default text indicating the date
and time when the memo was recorded and the length of the recording in seconds. You
can edit it like any other item.

You can select one or more items in any ToDo List document and Cut or  Copy them to
the clipboard. You can also copy text from any other application to the clipboard for
pasting in ToDo List. While most commands in ToDo List work the same way as they do
in other applications, the Paste command works a little differently and deserves a quick
explanation.

In ToDo List the Paste command only inserts the new items even if items are current
selected (other applications would replace the selected items), and items in the clipboard
are inserted according to their dates, priority and number of days overdue (if they have
them) or at the current default date. If dates aren't being displayed in the document, the
items get pasted at the end of the other priority items or at the end of the list. The items
that were pasted are left selected so as to see where they were inserted.

If the clipboard contains plain text (probably from another application), it is pasted in as a
single new non-priority item with the default date. If the text was longer than 255
characters, it is truncated to fit. Similarly, when you cut or copy items in ToDo List and
paste them in another application, they paste as plain text. ToDo List does format the text
with line breaks and spaces to make it look somewhat like the original items.

2.3 Printing ToDo Lists

For those occasions when you have to be away from your Macintosh, you can print the
contents of any of your ToDo List documents and take them with you. The format of the
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printout depends on the current Page Setup settings. If it is set up to print a vertical page,
ToDo List will print using four mini- pages on each page of paper. If it is set up to print
the page horizontally, ToDo List will print two mini-pages of items to a single page of
paper.

When you select the Print menu command, you’ll be presented with the following dialog
box:

You can set the title that will be printed at the top of each mini-page (it defaults to the
document name) and the either print all of the items in the document or only those whose
dates are within the given range. Note that even it dates aren’t being displayed in the
document window, all items still have a date associated with them, and it will be used to
determine which items are printed if you select the From option.

2.4 Audio Memos

It’s important to remember that recorded memos require about 5K of disk space for each
second of sound, so they can add significantly to the size of a ToDo List document. In
order to limit the amount of memory needed by ToDo List, memos are recorded and
played from memory, but are otherwise only stored on disk. Therefore, the ToDo List
application only needs enough free memory to hold just the single largest memo, but
enough disk space to hold all of the memos in the list. If you plan to make extensive use
of memos, you might want to increase ToDo List’s memory allocation  (Get Info... in the
Finder). and make sure that you have lots of disk space available.

Note that since any changes you make to a ToDo List document aren’t saved until you
select the “Save” menu item, memos are actually stored in an invisible temporary file and
automatically copied into the actual ToDo List document only when the document is
saved. Therefore, lists with large numbers of memos will take longer to save than lists
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without memos. Also, while the document is actually being saved, you’ll momentarily
need free space on your disk equal to about twice the size of document.  When you’re
playing a memo, you can cancel at anytime by pressing command-period ( -.). This is
especially useful if you mistakenly click on the speaker icon for a long memo item.

2.5 Drag and Drop

ToDo List includes complete support for Apple’s Drag Manager.  This means that you
can drag selected items within a list, between ToDo List document windows, or even
to/from other applications that support the Drag Manager (including the desktop).  This
feature makes it especially easy to keep your lists organized.

Using dragging in ToDo List is a very intuitive way to move items around.  First, select
the item or items that you want to move (you can select a range of items or even multiple
items that aren’t next to each other).  Then click the mouse while over one of the selected
items, drag to the new destination  and release.  While you’re dragging, ToDo List will
follow the mouse with a thick black insertion line that indicates where the items will be
inserted if you release the mouse button.  If you’re dragging the items within the list, they
will be deleted from their old location(s) and inserted at the new location.  If you hold the
Option key down while dragging within the list, the items will be copied.

When you drag items to a new location in a list, if necessary they will be modified to suit
the new location.  For instance, if you drag an item from one date to another, it’s date is
automatically changed.  Since priority items must always appear before non-priority
items within each date, the priority of a dragged item will also be modified to match its
new location (e.g. drag a non-priority item in front of a priority item and it will become a
priority item).

If you’re dragging items to another list or another application, by default the items are
copied and inserted at the new location without changing the source list.  If you want to
move the items to another list, hold down the command ( ) key during the drag and the
items will be deleted from the source list and inserted into the destination.  If you change
your mind, dragging can be undone, just select the Undo Drag Item(s) menu command
from the Edit menu when either the source or destination window is active.

If you drag items from ToDo List to another application, the result is the same as if you
copied the items and pasted them into the other program.  ToDo List automatically
converts the items into a plain text represen- tation that closely approximates their
appearance in ToDo List.  However you may choose to copy just the item text via a
setting in the Document Settings dialog. Any sounds that were associated with the
dragged items are lost when the items are dragged to another application or the desktop.

If you use other applications that also support the Drag Manager, dragging can be a very
convenient way to add new items. Just select some text in that application that you want
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for a new item, drag it over top of a ToDo List window and drop it into place.  You get a
new item with nothing more than a quick movement of the mouse!  When you drag text
from another application into ToDo List, any font styling information will be lost, and the
item will be clipped to a maximum of 255 characters.

If you have System 7.5, then the Drag Manager has been automatically installed.  If
you’re using an earlier version of System 7, then you’ll need to install the Drag Manager
if you want to be able to drag items between windows or to/from other applications.  The
Drag Manager is available from on-line services that carry Apple’s software as well as
FTP sites.  At the time this was written, it was available on “ftp.support.apple.com” in the
directory:
pub/Apple SW Updates/US/Macintosh/System Software/Other System
Software/
as the file: Mac Drag and Drop (1.1).hqx

This file is a complete development kit for Drag and Drop,  so it will include a lot of files
that you can simply ignore.  If you’re running System 7 Pro, you’ll only need the
extension called Drag and Drop.  If you’re running System 7.0 or System 7.1, you’ll
also need the extension called Dragging Enabler if you want to drag items to/from other
applications.  Only  System 7.5 supports dragging items to the desktop to create clippings
files.

2.6 Speaking Items

ToDo List will also speak items from your to do lists for you.  This can be a convenient
way to review what you have to do for the day while you’re moving around your office
getting organized.  Just select Read Today’s Item(s) from the Sound menu or press -R
and then you’re free to move around while ToDo List tells you want you’ve got planned
for the day.  If you want ToDo List to stop speaking, you can abort by pressing
command-period ( -.) at anytime.

You can select the voice ToDo List uses to speak in the Document Settings dialog.  You
can choose a different voice for each document to make it easy to distinguish one list
from another when you’re listening without looking at the screen.  You should note that
most of the voices provided by Apple require substantially more memory than the default
voice when in use.  If ToDo List doesn’t have enough memory available when you ask it
to read the list with a particular voice, it will try to use the default voice.

ToDo List uses the Speech Manager to speak the items in your list, so this feature is only
available if it has been installed.  If you’re running System 7.5, the Speech Manager was
automatically installed for you.  If you’re running an earlier version of System 7, you’ll
have to install it yourself. The Speech Manager should be available from Apple’s  FTP
sites.
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3  Importing and Exporting

ToDo List lets you: import/export to do items between any application that can work with
tab-delimited text files, create a world wide web page and synchronize a ToDo List
document to the to do items on a Newton PDA.

3.1 Import…

When you select the Import... sub-menu item from the Import/ Export menu item,
you’ll be asked to select a text file for importing.

ToDo List will check to see whether the first line in the file contains labels for the item
fields (when it exports a document, ToDo List puts the labels on the first line).  If the first
line contains labels, it will be ignored. The remainder of the file should contain one to do
item per line with each field separated by a single tab. Here is the order ToDo List
expects:

1. creation date
2. modification date
3. due date
4. priority (0 - 10)
5. completed status (“Finished” or “Not Finished”)
6. number of days overdue (0 - 15)
7. text of the item (carriage returns are replaced with "##")

ToDo List will do its best to translate date/time formats (e.g. “Jan 1, 1996” or “1/1/96”).
If an error is detected, the whole import is cancelled and only the items preceeding the
erroneous one are imported.

Many database applications and other personal information managers can be made to
export to do items in the above format.

3.2 Export…

When you select the Export... sub-menu item from under the Import/Export menu item,
you’ll be asked to enter a new file name for exporting. ToDo List will write labels for all
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of the item fields in the first line. The remainder of the file will contain one to do item per
line, tab delimited with the fields in the order described above. If the text of any item
contains carriage returns, they will automatically be replaced by "##".

3.3 Export HTML…

This option provides a convenient way to publish a ToDo List document on the World-
Wide Web (part of the internet). If you’re unfamiliar with the internet, you can simply
ignore this menu command.

When you select the Export HTML... sub-menu item from under the Import/Export
menu item, you’ll be asked for a new file name. ToDo List will export all of the items in
the file in HTML format. The exported document is given a title and a footnote indicating
that the document came from ToDo List. ToDo List creates a NetScape Navigator
document, but it is actually a plain text file that can be used by any browser application.

If you have Internet Config installed on your Macintosh (it ships with many internet
applications and is available in archives such as Info-Mac), ToDo List will search for
valid URLs. If found, they will be written so that it provides an actual link.

3.4 Synchronize Newton…

This option provides a convenient way to synchronize the to do items on a Newton PDA
with the contents of the ToDo List document.  If you don’t have a Newton, you can
simply ignore this menu item.

In order to use this menu command, you will first need to install the ToDo List Sync
package on your Newton.  Since the Newton always carries unfinished items forward to
the current date and the to do items in the Newton Date Book always have dates, your
ToDo List document will automatically have these options set the first time you
synchronize.

To begin synchronizing select the Synchronize Newton... menu command on the
Macintosh and tap the ToDo Sync application in the Extras Drawer. You can
synchronize with your Newton via the serial port (either Printer or Modem), via an
AppleTalk network, or via a modem connection. Make sure you select the same
connection method on both the Macintosh and Newton and that they have been properly
connected. Tap the Connect button on the Newton and click OK on the Macintosh to
begin the synchronization.
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HINT: When you synchronize in the future, if you hold the option key down while
selecting the Synchronize Newton... menu command, no dialog will appear and the last
connection method will be automatically used again.

The first time you synchronize your Newton with a ToDo List document, all of the items
in the ToDo List document will be added to the Newton’s list and visa versa. Note that
ToDo List doesn’t make any attempt to actually compare the content of items. If an item
on the Macintosh has the same text as an item on the Newton, they are still treated as
different and you’ll end up with both in each list.

During the first synchronization, ToDo List creates an internal link between each item in
the ToDo List document and the corresponding item on the Newton.Each time you
synchronize in the future, any changes that were made to items will be copied to the
corresponding item on the other side.

If you change the same item on both the Macintosh and the Newton, the Newton-
based change will take priority and the Macintosh change will be lost.

If you delete an item on the Newton, the corresponding item on the Macintosh will be
deleted. Similarly, if you delete an item on the Macintosh, the corresponding item on the
Newton is deleted.

It’s important to remember the invisible correspondences that were created between
corresponding items on the Newton and the Macintosh, independent of their text content.
If you completely change the text of an item on the Newton (so that in your mind it’s now
a new item) and change the corresponding item on the Macintosh so that it also appears
to be a different item, the connection between the two still exists. The next time you
synchronize the two lists, the change on the Newton will override the change on the
Macintosh. As long as you remember to delete items when you’re finished with them
rather than reuse them, you won’t have any problems.

The synchronization information for the corresponding Macintosh ToDo List document is
stored on the Newton in a way that actually allows you to keep several Newtons
synchronized with each other via a single Macintosh. If you synchronize a Newton with a
ToDo List document, synchronize another Newton with the same list and then
resynchronize the first Newton again, both Newtons will end up with exactly the same to
do items.  With a little care, you could use this technique to keep the to do items on
several Newtons (for instance, all of your sales force) synchronized so that they can share
tasks from day to day.
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3.5 Collect Browser URLs

By selecting this menu choice (there must be a checkmark next to the command in order
for the option to be active) you will automatically create a list of all the Web pages
("URLs") you visit when using your browser. We can recommend Netscape's Navigator
and Microsoft's Explorer as compatible browsers.

This functionality works in the background and requires that you have InternetConfig
(which is free and comes with MacOS 8.0 and later) installed. You can stop the collection
of Web pages by selecting the command again (this will remove the checkmark in front
of the menu item.) This list is also a working bookmark list so that if you command-click
a line, you will be taken to that Web page.
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4  Menus

This chapter provides a description of all of the menu items in ToDo List. Use the Quick
Start chapter to get started with ToDo List and use this chapter as a reference when you
need details about a particular command.

4.1 The Apple Menu

The Apple menu contains only one item specific to ToDo List:

About ToDo List...

If you have not purchased your copy of ToDo List there will be a Register button below
the Serac Software logo. Clicking this button will step you through the process of buying
the software. In the future you may re-register your copy by double-clicking your name.
See the last chapter: Registering, for additional information on this process.

ToDo List is distributed as a “fat application”, which means that it includes instructions
(binary code) for both the original 680x0-based Macintoshes and the new Power
Macintoshes. While including the binary code for both machine types makes ToDo List
as efficient as possible on either machine, it also makes the application a bit larger.

If you know that you will only ever be using it on one type of Macintosh, you can use the
Remove Unused button to strip away the code that isn’t needed for the type of Macintosh
that ToDo List is currently running on. This operation cannot be undone – keep a backup
copy of the original application. If you have already preformed this step the button will
be removed. Also this button will be disabled if the application is locked or is running
from a locked volume or a server.

If you want to find out which version of ToDo List you have without launching it, select
it in the Finder and choose Get Info from the File menu. The information window tells
you the version number (e.g. 1.0) and whether it is a “Fat” , “680x0” or “Power Mac
Only” application.

If you use Remove Unused when running on an original 680x0-based Macintosh, it will
eliminate the “native” Power Macintosh code. This modified version of ToDo List will
still work on Power Macintoshes, it just won’t be as efficient as the original. On the other
hand, if you use Remove Unused when running on a Power Macintosh, the modified
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version will only work on Power Macintoshes. If you try to use in on a non-Power
Macintosh, you’ll get a warning and the application won’t launch.

4.2 The File Menu

The File menu contains commands that apply to ToDo List documents:

New...
Use the New... command to create a new ToDo List document. A new window will be
created with the default name "untitled". If a document with that name is already open,
ToDo List will add a number to the end to make a unique name. Any changes you make
to the document won't be saved until you select Save or Save As... from the File menu.
At that time you'll be presented with a standard file dialog box.  A new document's
characteristics are set by the Edit menu's "Default Document Settings..." menu item
which is available when there are no open documents.

Open...
The Open... menu command lets you open an existing ToDo List document. The contents
of the document are displayed in a new window. The location and size of the window are
automatically set to be the same as the last time the document was open.

If the "Carry Forward Unfinished Items" preference is set for this document (see the
Preferences section), then as the document is opened, any items with a date prior to the
current date that have not been checked off will be moved to the current date. If the
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“Display Overdue Days” preference is set, the number of days each carried forward item
was overdue will be displayed next to the item’s checkbox.

Close
Select Close to close the active ToDo List document. If there are any changes to the
document that haven't been saved yet, you'll be asked if you want to save the changes. If
the "Automatically Save Changes At Close/Quit" preference is set, you won't be asked
and the changes will just be saved.

This command will close the Find Dialog if it is the currently active window.

Save
Select Save to save any changes to the active document. This item is only enabled if
you've made changes since opening or last saving the document.

Save As...
Select Save As... to save the active document as a new document.

Revert
Selecting Revert will cause ToDo List to discard any changes made to the active
document since it was opened or the last time it was saved. This operation cannot be
undone, so be careful. This command is only enabled if the document currently has
unsaved changes.

Save All Windows
Saves changes in all of the open documents. This item is only enabled if you've made
changes since opening or last saving at least one document.

Page Setup...
The Page Setup command displays the standard page setup dialog for the currently
selected printer. If a horizontal page orientation is selected, ToDo List prints two mini-
pages of items on a single page. If the vertical page orientation is selected, ToDo list
prints four mini-pages of items per page.

Print...
The Print... command displays a dialog box asking for the range of items to be printed
from the currently active ToDo List document.

You can select "All" or only those items that fall between selected dates. You can also
specify a title to appear at the top of each page.
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Preferences...
Selecting "Preferences" displays a dialog box listing all of the current user preferences.
These preferences apply to the ToDo List application as a whole. See the Preferences
section for more details.

Quit
Select Quit to quit from ToDo List. If the "Auto-Open Documents On Startup"
preference is set (see the Preferences section), ToDo List will remember which
documents were open.

If any of the currently open documents have unsaved changes, you'll be asked if you want
to save them. If the "Automatically Save at Close/Quit" preference is set, then they will
be saved without asking.

4.3 The Edit Menu
 

Undo <last-command> or Redo <last-command>
Almost all actions in ToDo List can be "undone" and "redone" again if desired. This
menu item is constantly updated to indicate what the last action was. This item is only
enabled when the last action occurred in the currently active (frontmost) window.
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Cut
The currently selected item or items are copied to the clipboard and removed from the
list. This menu command is only enabled when one or more items are selected. ToDo List
supports command-clicking for discontinuous selections, shift-clicking to extend the
selection, etc.

Copy
The currently selected item or items are copied to the clipboard. This menu command is
only enabled when one or more items are selected.

Paste
The current contents of the clipboard are inserted into the ToDo List document at the
position determined by their date (if dates are displayed), or at the current date (usually
the end of the list). If plain text is in the clipboard, a new item is created with the default
date and the text is truncated to 255 characters if necessary.  Unlike other Macintosh
applications, Paste will not replace selected items.

Clear
The currently selected item or items are removed from the list. If the "Confirm Deletes"
preference is set, ToDo List will ask you if you're sure you want to delete the item(s)
before proceeding.

Select All
This command selects all of the items in the list

Select Finished
This command selects all of the finished items in the list.  This is useful if you want to get
rid of the finished items in the list, but you still want to keep a copy of them somewhere.
Use this command to select all of the finished items.  Then use the Cut command to copy
them to the clipboard and remove them from this list.  Finally, switch to another ToDo
List document (one you’ve created just for archiving finished items) and select Paste.

Import/Export
The commands under this menu item let you import items from a text file, export items to
a text file or HTML (World Wide Web) page, synchronize the ToDo list document with
the to do items on a Newton or capture a list of Web page URLs as you visit them in your
browser. See the previous section Importing and Exporting for complete details.

Document Settings...
This command displays a dialog box that lets you adjust a variety of options for the active
(front-most) ToDo List document.  For instance, some documents can display dates while
others do not. If no ToDo List documents are currently open, then menu command
changes to Default Document Settings... and it will let you change the default settings
for new documents. (see Preferences & Document Settings)
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4.4 The Item Menu

 

Insert New Item...
A dialog box will appear in which you can type the text of the new item (see the
Creating/Editing Items section in Getting Started). The date defaults to the last date
you’ve used or today's date. To start a new line in the text of the item, hold down the
Option, Shift, or Control key while pressing the Return key. Just pressing Return
alone will be treated as a click on the OK button (note that this behavior can be reversed
if you frequently use multi-line items -- see Preferences).

Edit Item...
Select this command to change the text or date of an item. A dialog box like the one used
by the New Item... command will appear. This command is only enabled when only one
item is selected (highlighted).

Toggle Finished Status
This command reverses the “finished” status of the selected item or items. If an item
doesn’t have a check mark next to it, this command will check it off. If the item is already
checked (finished), then this command unchecks it. This menu command is only enabled
when one or more items are selected. ToDo List supports command-clicking for
discontinuous selections, shift-clicking to extend the selection, etc.

Toggle Priority Status
This command reverses the priority status of the selected item or items. Priority items
selected become non-priority, and any non-priority items selected will become priority
items.  Note that when the items change priority status, some of them may move up or
down in the list so that priority items remain at the top of each day (or the top of the list if
dates aren’t being displayed). This menu command is only enabled when one or more
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items are selected. ToDo List supports command-clicking for discontinuous selections,
shift-clicking to extend the selection, etc.

Find...
To search for some text in the ToDo List window, select the "Find..." command. A dialog
like the following will be displayed:

You can leave the Find Dialog displayed while switching between other ToDo List
windows.  Click the Find button to begin a search or find the next item that matches.  The
search applies to the ToDo List document that is front-most.  If Search Backward is set,
the search will start at the end of the list and work back to the start of the list. Note that
ToDo List currently does not include the dates in the search when dates are displayed in
the window. Comparisons are made using the international facilities built in to the
Macintosh, so they should match correctly for the current country.  Click the Find All
button to have ToDo List go through the entire list of items and select every item that
matches the search string.

Find Again or Find Backward Again
To repeat the previous search, select the "Find Again" command. The next item matching
the previous search will be found. This command is only available if you have previously
searched for something. It searches in the same direction as the last Find. The search
begins where the last search left off, or with the item that was most recently “touched” in
the list (e.g. the item that was last edited).

Goto URL...
This menu command gives you convenient access to the internet from ToDo List. If you
aren’t familiar with the internet, you can just ignore this command. If Internet Config
has been installed on your Macintosh, you have exactly one item selected and that item
appears to be a valid URL, this menu command will launch the appropriate internet
application and go to the URL in the item.
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Remove Finished Item(s) or Remove Selected Finished Item(s)
If no items are currently selected, this command deletes all of the items in the list that are
currently checked-off or “finished”. If any items are currently selected, only finished
items among the selected items are deleted. This command is disabled if there are no
finished items in the selection or complete list. If the Confirm Before Deleting Item(s)
preference is on, you’ll be warned before the items are deleted.

4.5 The Sound Menu

 

Record New Memo...
This command brings up a recording control panel and creates a new item with the
recorded memo and default text indicating the date and time when the memo was
recorded and its length in seconds.

Play Memo
This command plays the audio memo associated with the currently selected item. This
menu command is only enabled when exactly one item is currently selected and that item
has a recording.

Erase Memo(s)
This command erases the audio memo associated with the currently selected item or
items. This menu command is only enabled when one or more items are currently
selected and at least one has a recording.

Read Today's Items
This command uses the Speech Manager to read all of the unfinished items for the
current date. If any of the unfinished items have recordings, the audio is also played. This
item isn’t enabled if the Speech Manager isn’t currently installed (part of System 7.5).

Read All Items or Read Selected Items
If no items are currently selected, this command uses the Speech Manager to read all of
the unfinished items in the list. If any items are currently selected, only unfinished items
among the selected items are read. If dates are displayed in the document, then it also
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reads the dates. If any of the unfinished items have recordings, the audio is also played.
This item isn’t enabled if the Speech Manager isn’t currently installed.

4.6 The Window Menu

This dynamic menu contains one entry for each open ToDo List document. Just select the
document's name in the menu to bring that document to the front. The document name’s
are listed in alphabetical order. The document that is currently frontmost (active) will
have a check next to it in the menu.

You can also use the Window menu to check which documents you’ve changed;
documents with changes appear underlined until they are saved.
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5  Preferences and Document Settings

You can customize a number of features of ToDo List. Preferences are general to the
whole application and apply to any and all open ToDo List documents. Document
Settings are specific to each ToDo List document.

5.1 General Preferences

To customize ToDo List, select Preferences from the File menu. A dialog box like the
following will appear:

 

All of these items apply to the ToDo List application in general and will affect every
document that you have open.

Auto-Open Documents on Startup
When this option is checked, each time you open ToDo List, it will auto- matically
reopen any documents that were open the last time you used it.

Confirm Before Deleting Item(s)
When this option is checked, each time you delete (Clear in the Edit menu) the selected
items, a dialog box will appear asking you if you're sure that you want to delete the
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item(s). Until you perform another command, deleted items can be restored by selecting
Undo Clear from the Edit menu, so this option isn’t essential and defaults to off. If this
option is checked, you’ll also get the warning when using the Remove Finished Item(s)
command.

Play Sound When Toggling Items
When this checkbox is checked, each time you change the finished state of an item, the
sound of a pencil making a check mark on paper is played. Uncheck this if you no longer
want to here the sound.

Pressing <Return> in Item Dialog Same as OK
If this checkbox is checked, when you’re editing or creating a ToDo List item, pressing
the Return key will click the OK button for you. If this is unchecked, then pressing
Return will insert a new line into the text of the item. Holding down the Option,
Control, or Shift keys when pressing Return  momentarily reverses the setting of this
preference.

Auto-Save
If this checkbox is checked, then ToDo List will automatically save changes that you
make to open ToDo List documents.  Changes can be automatically saved at regular
intervals, or just when you close a document or quit.

At Close or Quit
ToDo List normally works like any other application, when you make changes to an open
document, the changes aren’t actually saved until you select Save from the File menu. If
you have changes pending when you close a window or quit,  ToDo List will ask you if
you want to save the changes. This preferences lets you change this default behavior. If
At Close or Quit is selected, then ToDo List will automatically save any pending
changes when you close a window or quit.

Every xx Minutes
If Every xx Minutes is selected, then ToDo list will automatically save any pending
changes in all open ToDo List documents at the given interval. For instance, if “Every 10
Minutes” were selected, then once every 10 minutes ToDo List would go through all of
the open ToDo List documents and any with pending changes would be automatically
saved.  New documents are not automatically saved until they have been saved at least
once manually (so that they have a name and location on your disk).

5.2 Document Settings

These are settings that apply only to the active ToDo List document. To change a ToDo
List document click on its window and then select "Document Settings..." from the Edit
Menu.
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Display Dates Using
The selected font and size will be used to display the dates in the currently active ToDo
List if it is set to display items by date. All fonts in the system and a selection of sizes are
displayed. Sizes that don’t require scaling are displayed in outline text.

Display Items Using
The selected font and size will be used to display all items in the currently active
document. All fonts in the system and a selection of font sizes are displayed. Sizes that
don’t require scaling are displayed in outline text.

Only Copy Text To Clipboard
If checked only the text of an item when copied or dragged will be transferred (e.g. no
checkbox, priority or date.) For example, if you access the Internet and select this setting,
you can create a list of URL's and drag one to a compatible browser's window (ie.
Netscape) to automatically jump to that WWW page.

Display Miniature Calendar  (Use Small Font)
If this checkbox is checked, then a small calendar will be displayed across the top of the
ToDo List document. It will display as many months as possible for the current window
width. By using the arrows on either side, you can scroll the months displayed. The "Use
Small Font" checkbox determines the size of the font used to display the calendar.

A single click on a day in the calendar will scroll the list of items so that the first item on
or after that date will be at the top. Double-clicking on a day in the calendar will create a
new item.
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Dates With ToDo Items
If this box is checked, then ToDo List associates each item in the list with a particular
date. When you create a new item ToDo List automatically inserts the default date
(today’s date or the last date you manually specified). You can also change the date for
an item when you edit it, or by dragging it to a new location in the list.

Typically you’ll have some lists that include dates (for items that were done or need to be
done on a particular day) and other lists without dates (for items that don’t easily
associate with a particular date, like a grocery list).

Show Days Overdue
If you’re displaying dates and items were automatically carried forward, checking this
box will cause ToDo List to display a small number to the right of the checkbox that
indicates the number of days the item was carried forward. It will display “1” to “9” or
“>” for ten or more days.

Carry Unfinished Items Forward
ToDo List can automatically move unfinished items from earlier dates forward to today’s
date each time the file is opened, or at midnight if ToDo List is still running. Note that
items are not immediately carried forward if you create them with an old date. Also there
is no Undo for the carry-forward action – if you change your mind you’ll have to Revert
the document to the previously saved version.

Speak Items Using
This popup menu lists all voices currently installed in your system along with a special
entry: “Default Voice”.  Select the voice to be used when speaking items in the list.  If the
selected voice later becomes unavailable or there isn’t sufficient memory, ToDo List will
use the default voice.
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6  Scripting ToDo List

The ToDo List application is fully scriptable – anything that you can do to a document
using the keyboard and mouse, can be done by a script using the AppleEvents supported
by ToDo List.  Using AppleScript (which is available for free on every Macintosh), you
can create powerful custom solutions that combine the features of ToDo List with other
scriptable applications.  For example, you might already be using ToDo List as a
convenient place to keep a list of files you plan to download from Info-Mac.  With a
simple script, you could automatically iterate through all of the items in the list and for
each, use Anarchie (which is also scriptable) to download the file to your machine.
 This chapter provides an overview of the elements in ToDo List that you can control,
and the commands that are available to control them.  It assumes that you already have
some familiarity with AppleScript.

6.1 The ToDo List Elements

Scriptable applications are typically made up of a variety of elements that can be
specified (the 5th item of the document "Stuff")  and a set of actions that can be
performed on those elements.  ToDo List provides a hierarchy of element types and a
variety of ways to refer to them.
At the top of the hierarchy is a single application.  The application has a number of
properties (that correspond to the current preferences) that can be addressed directly:

autoOpen  boolean  -- should ToDo List automatically open your last documents when
launched

confirmDelete  boolean  -- confirm deletes

play toggle sound  boolean  -- play sound when toggling items

saveOnClose  boolean  -- automatically save documents on close

saveInterval  integer  -- save documents after this number of minutes (0 = don't auto-
save)

returnKeyClicksOK  boolean  -- <return> same as hitting OK in item dialog

You can retrieve or change any of these properties using AppleScript:
set areWeAutoOpening to the autoOpen of application "ToDo List"
set the autoOpen of application "ToDo List" to true

The application also contains some number of document elements (one for each ToDo
List document).  You can refer to the documents by name or by index:

document "Things To Do" of application "ToDo List"
document 3 of application "ToDo List"

Each document has several properties that can be addressed directly:
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name  string  -- the title of the document

show calendar  boolean  -- should the calendar be shown across the top of the document

use dates  boolean  -- should all items have a due date associated with them

show overdue  boolean  -- show how many days each item is overdue

carryforward unfinished  boolean  -- should unfinished items be carried forward

date font  string  -- font to use for displaying dates

date size  integer  -- size of font for displaying dates

item font  string  -- font for displaying items

item size  integer  -- font size for displaying items

clipboard text only  boolean  -- should copying to the clipboard copy only text

voice  string  -- voice that should be used for speaking items

useSmallCalendarFont  boolean  -- if true, then a very small font is used for calendar

You can change these properties using AppleScript:

tell application "ToDo List"
   set the date font of document "Important Stuff" to "Times"
   set the show overdue of document 4 to false
end tell

Documents also contain some number of item elements.  These elements can be accessed
by index:
item 5 of document 4

If the list is using due dates, then items can also be accessed via the date:
item 3 of date "1/13/96" of document 4
item 6 of date "June 1, 1996" of document "Stuff"

Each item has a number of properties that you can retrieve or set:
uniqueID  integer  [r/o]  -- a unique ID for the to do item

description  string  -- the text of the to do item

dueDate  string  -- the date the item should be done on

completed  boolean  -- has the item been completed (true or false)

created  string  [r/o]  -- date and time that the item was created

priority  integer  -- priority of the item (0 - 10, 0 = none, 1 = highest)

modified  string  [r/o]  -- date and time that the item was last modified

selected  boolean  -- true if the item is currently selected

You can access these properties from AppleScript by just fully specifying the item and
property.  For example:
tell application "ToDo List"
   -- Check off an item as finished
   set the completed of item 4 of document "Important Stuff" to true
   -- Change the due date of an item
   set the dueDate of item 2 of date "5/16/96" of
                document 3 to "May 20, 1996"
end tell

You can create new elements using the make command.
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6.2 AppleScript Commands

ToDo List supports the standard open, print, and quit AppleEvents, so you can easily
get it to launch and open a set of ToDo List documents.  It also lets you save and close
documents as needed:

save: save the document to disk
save  document

[in  alias]  -- file to save the document in

close: close the document's window
close  document  -- document to close

[saving  yes/no/ask]  -- should any changes be saved

[saving in  alias]  -- file to save the document in

For example:
tell application "ToDo List"
   open alias "My Harddisk:Lists:Stuff To Do"
   set the voice of document "Stuff To Do" to "Victoria"
   save document "Stuff To Do"
   close document "Stuff To Do"
end tell

ToDo List also supports several core AppleEvents that let you count, create, delete, etc.
the various elements that it defines:

count: count the number of elements in a class
count  reference  -- the object whose elements are to be counted

each  type class  -- the class of the elements to be counted.

Result:   integer  -- the number of elements in the given class

For example:
tell application "ToDo List"
   set cnt to count of documents
   set numItems to count of item of document 3
   set dayItems to count each item of date "5/6/96" of document "Stuff"
   set numDates to count each date of document 1
end tell

get: get data for a to do item
get  reference  -- reference to the item to get

Result:   anything  -- data for the requested to do item
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set: set an item or property of an item to some value
set  reference  -- the item or item property to change

to  anything  -- new value for the item or property

make: make a new item
make

new  type class
[at  integer]
with properties  record
within  reference  -- the document to which the new item should be added

Result:   integer  -- index of the new item

Makes a new item of the given type ("item" or "document").  Any unspecified properties
default to the same values as they would if the item were created directly in ToDo List.
For example:
tell application "ToDo List"
   -- Note: make new document doesn't support 'with properties'!
   set docNum to make new document
   set docName to get name of document docNum
   set the use dates of document docName to true
   make new item at 1 within document docName
       with properties { description:"testing", priority: 1,
                        dueDate:"Feb 1, 1996"}
   make new item at 9999 within document docName
       with properties { description:"testing", priority: 0,
                        completed: true, dueDate:"Feb 1, 1996"}
end tell

delete: delete an item from the document
delete  reference  -- the item to delete

  For example:
tell application "ToDo List"
   delete item 1 of document "Stuff"
   delete item 1 of date "5/5/96" of document 2
end tell

move: move the referenced item to a new location, changing its due date and priority if
necessary

move  reference  -- a reference to the item to be moved

to  integer  -- index of the location the item should be moved to

Moves an item from one location to anotherwithin the same document.  If necessary, the
priority or due date of the item will be modified to match the new location.  For example:
tell application "ToDo List"
   -- Move the first item to the end of the list
   move item 1 of document "Stuff" to 9999
   -- Swap the first and second items
   move item 1 of document "Stuff" to 2
end tell
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ToDo List also supports several custom AppleEvents that let you control the special
features of the application:

SpeakItems: Read all of the unfinished items in the list
SpeakItems  document  -- the ToDo List document to speak items from

SpeakTodaysItems: Read all of the unfinished items for today
SpeakTodaysItems  document  -- the ToDo List document to read today's items from

synchronizeNewton: synchronize the given document with a Newton
synchronizeNewton  document  -- the ToDo List document to synchronize to

[via  serial-modem/serial-printer/modem/AppleTalk]
-- synchronize Newton using this connection (serial, AppleTalk, modem)

[using  string]  -- option string for the connection

export: export the selected items (or all if none are selected) in the given ToDo List
document to a tab-delimited text file.
export  document  -- the ToDo List document to export to a text file

[as  text/HTML]  -- type of document to create (text or HTML).

[in  alias]  -- the file to export the ToDo List document into

import: import items from a tab-delimited text file
import  document  -- the ToDo List document to import the items into

[from  alias]  -- the tab-delimited text file to import the items from
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7  Registering ToDo List

If you have not purchased your copy of ToDo List there will be a "Registration... "
button in the About Box.  (If your copy is already registered, the button will no longer be
visible.  If you need to reregister with a different name and key, double-click on the
"Registered to" information behaves the same as the button.)

ToDo List is only distributed as a full version with no features missing or disabled.
However, it will only work for 30 days before requiring you to register your copy (you
can of course, register at any time prior to the expiration).  ToDo List costs only $25 and
you can easily register on-line by credit card.  You can also register by email, fax or mail
with a check.

We use the Kagi, Inc. to collect fees for ToDo List.  Kagi is a high respected payment
service has been in business for several years and currently handles thousands of different
products and tens of thousands of transactions per year.  By using Kagi we're able to cost
effectively accept a wide variety of payment methods.  If you have questions about your
payment, you can contact Kagi.  For all other questions relating to ToDo List, you should
contact Serac Software directly (support@seracsoftware.com).

7.1 Registration

Open the About Box for ToDo List and click the Registration button to open a
registration dialog box that gives you a choice of registering on-line, registering using the
Register ToDo List application, or completing your registration if you've gotten your
registration key back.

7.2 Registering On-Line

If you wish to register on-line, click on the "Register Online..." button.  This will launch
your favorite browser (using Internet Config) and take you to the ToDo List registration
web page.  If you don't have internet config installed, you can also go directly to the web
page:

    http://order.kagi.com/WB?

Once you've gone to the order web page, follow the instructions to pay for ToDo List.
Within 3 business days you'll receive a personal key for your copy of ToDo List.  Once
that key arrives, you can go back to the About Box, click on the "Registration..." button
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again and click on the "Finish Registration..." button to get to a dialog like the
following:

Enter your name exactly the same as you did when you registered.  The company name is
optional.  If you ever move to a new computer you'll need to reenter your personal key,
so please make sure that you also write it down and store it someplace safe.  After you've
entered your key and clicked on the OK button, ToDo List will need to quit in order to
complete the registration process.

7.3 Registering By E-mail, Fax or Mail

If you wish to order via eMail, Fax or Mail, click the "Register Other..." button.  This
will launch the Register ToDo List application that comes with ToDo List.  You can then
fill in the form that is displayed.  Once you select this option your trial period will be
extended by 15 days in order to allow you to continue to use ToDo List until you receive
your personal registration key.

7.4 Contacting Us

By Email:
     support@seracsoftware.com

Or on the web at:
     http://www.seracsoftware.com/

Suggesting New Features
We encourage you to send feature or interface ideas, please send them to the above
address.
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8  Software License

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT ("LICENSE") CAREFULLY BEFORE
USING  iRemember ("SOFTWARE"). BY USING THE SOFTWARE, YOU ARE AGREEING TO BE
BOUND BY THE TERMS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF THIS
LICENSE, PROMPTLY RETURN THE SOFTWARE TO THE PLACE WHERE YOU OBTAINED IT
FOR A REFUND.
1. License. The software and any fonts accompanying this License whether on disk, in read only memory,
or on any other media (the “Software”) are licensed, not sold, to you by Serac Software. You own the
media on which the Software is recorded but Serac Software and/or Serac Software's licensor(s) retain title
to the Software. The Software in this package and any copies which this License authorizes you to make
are subject to this License.
2. Permitted Uses and Restrictions. This License allows you to install and use the Software on a single
computer at a time. This License does not allow the Software to exist on more than one computer at a time.
You may make one copy of the Software in machine-readable form for backup purposes only. The backup
copy must include all copyright information contained on the original. Except as permitted by applicable
law and this License, you may not decompile, reverse engineer, disassemble, modify, rent, lease, loan,
distribute, sublicense, create derivative works from the Software or transmit the Software over a network.
You may, however, transfer your rights under this License provided you transfer the related documentation,
this License and a copy of the Software to a party who agrees to accept the terms of this License and
destroy any other copies of the Software in your possession. Your rights under this License will terminate
automatically without notice from Serac Software if you fail to comply with any term(s) of this License.
3. Limited Warranty on Media. Serac Software warrants the media on which the Software is recorded to
be free from defects in materials and workmanship under normal use for a period of ninety (90) days from
the date of original retail purchase. Your exclusive remedy under this paragraph shall be, at Serac
Software’s option, a refund of the purchase price of the product containing the Software or replacement of
the Software which is returned to Serac Software or a Serac Software authorized representative with a copy
of the receipt. THIS LIMITED WARRANTY AND ANY IMPLIED WARRANTIES ON THE MEDIA
INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE
OF ORIGINAL RETAIL PURCHASE. SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS ON
HOW LONG AN IMPLIED WARRANTY LASTS, SO THIS LIMITATION MAY NOT APPLY TO
YOU. THE LIMITED WARRANTY SET FORTH HEREIN IS EXCLUSIVE AND IN LIEU OF ALL
OTHERS, WHETHER ORAL OR WRITTEN, EXPRESS OR IMPLIED. SERAC SOFTWARE
SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES. THIS LIMITED WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY
BY JURISDICTION.
4. Disclaimer of Warranty on Software. You expressly acknowledge and agree that use of the Software is
at your sole risk. The Software is provided “AS IS” and without warranty of any kind and Serac Software
and Serac Software's licensor(s) (for the purposes of provisions 4 and 5, Serac Software and Serac
Software's licensor(s) shall be collectively referred to as "Serac Software") EXPRESSLY DISCLAIM ALL
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. SERAC
SOFTWARE DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE
WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE
UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE
CORRECTED. FURTHERMORE, SERAC SOFTWARE DOES NOT WARRANT OR MAKE ANY
REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE
SOFTWARE OR RELATED DOCUMENTATION IN TERMS OF THEIR CORRECTNESS,
ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR
ADVICE GIVEN BY SERAC SOFTWARE OR A SERAC SOFTWARE AUTHORIZED
REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE
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OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (AND NOT SERAC
SOFTWARE OR A SERAC SOFTWARE AUTHORIZED REPRESENTATIVE) ASSUME THE
ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE
ABOVE EXCLUSION MAY NOT APPLY TO YOU.
5. Limitation of Liability. UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL
SERAC SOFTWARE BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR
CONSEQUENTIAL DAMAGES ARISING OUT OF OR RELATING TO THIS LICENSE. SOME
JURISDICTIONS DO NOT ALLOW THE LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES SO THIS LIMITATION MAY NOT APPLY TO YOU. In no event shall Serac Software's
total liability to you for all damages exceed the amount paid for this License to the Software.
6. Export Law Assurances. You may not use or otherwise export or reexport the Software except as
authorized by United States law and the laws of the jurisdiction in which the Software was obtained. In
particular, but without limitation, none of the Software may be used or otherwise exported or reexported (i)
into (or to a national or resident of) a United States embargoed country or (ii) to anyone on the U.S.
Treasury Department's list of Specially Designated Nationals or the U.S. Department of Commerce's Table
of Denial Orders. By using the Software, you represent and warrant that you are not located in, under
control of, or a national or resident of any such country or on any such list.
7. Government End Users. If the Software is supplied to the United States Government, the Software is
classified as "restricted computer software" as defined in clause 52.227-19 of the FAR. The United States
Government's rights to the Software are as provided in clause 52.227-19 of the FAR.
8. Controlling Law and Severability. This License shall be governed by the laws of the United States and
the State of California. If for any reason a court of competent jurisdiction finds any provision, or portion
thereof, to be unenforceable, the remainder of this License shall continue in full force and effect.
9. Complete Agreement. This License constitutes the entire agreement between the parties with respect to
the use of the Software and supersedes all prior or contemporaneous understandings regarding such subject
matter. No amendment to or modification of this License will be binding unless in writing and signed by
Serac Software.


